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Relevant products 

Product name Model Part number 

PCAN-PC/104 Single Channel One CAN channel IPEH-002054 

PCAN-PC/104 Dual Channel Two CAN channels IPEH-002055 

PCAN-PC/104 Single Channel 
opto-decoupled 

One CAN channel, galvanic 
isolation for CAN connection 
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PCAN-PC/104 Dual Channel 
opto-decoupled 

Two CAN channels, galvanic 
isolation for CAN connections 

IPEH-002057 
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1 Introduction 

The PCAN-PC/104 card enables the connection of one or two CAN 
networks to a PC/104 system. Multiple PCAN-PC/104 cards can 
easily be operated using interrupt sharing. 

The card is available as a single or dual-channel version. The opto-
decoupled versions also guarantee galvanic isolation of up to 500 
Volts between the PC and the CAN sides. 

The monitor software PCAN-View and the programming interface 
PCAN-Basic for the development of applications with CAN 
connection are included in the scope of supply. 

Device drivers exist for different operating systems, so programs 
can easily access a connected CAN bus. 

Tip: At the end of this manual (Appendix C) you can find a 
Quick Reference with brief information about the installation 
and operation of the PCAN-PC/104 card. 

1.1 Properties at a Glance 

 Form factor PC/104 

 Multiple PC/104 cards can be operated in parallel 
(interrupt sharing) 

 14 port and 8 interrupt addresses are available for configuration 
using jumpers 

 1 or 2 High-speed CAN channels (ISO 11898-2) 

 Bit rates from 5 kbit/s up to 1 Mbit/s 
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 Compliant with CAN specifications 2.0A (11-bit ID)  
and 2.0B (29-bit ID) 

 Connection to CAN bus through D-Sub slot bracket,  
9-pin (in accordance with CiA® 303-1) 

 NXP SJA1000 CAN controller, 16 MHz clock frequency 

 NXP PCA82C251 CAN transceiver 

 5-Volt supply to the CAN connection can be connected through a 
solder jumper, e.g. for external bus converter 

 Galvanic isolation on the CAN connection up to 500 V (only 
opto-decoupled models), separate for each CAN channel 

 Extended operating temperature range of -40 to +85 °C (-40 to 
+185 °F) 

Note: This manual describes the use of the PCAN-PC/104 card 
with Windows. You can find device drivers for Linux and the 
corresponding application information on the provided DVD in 
the directory branch Develop and on our website under 
www.peak-system.com/linux. 

1.2 System Requirements 

 PC/104 stack with ISA bus (according to the PC/104 specification) 

 Operating system Windows 10, 8.1, 7 (32-bit),  
or Windows CE 6.x (x86 and ARMv4 processor support),  
or Linux (32/64-bit) 

http://www.peak-system.com/linux�
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1.3 Scope of Supply 

 PCAN-PC/104 card 

 Slot bracket with D-Sub connectors for the CAN bus 

 Device drivers for Windows 10, 8.1, 7 (32-bit) 
and Linux (32/64-bit) 

 Device driver for Windows CE 6.x  
(x86 and ARMv4 processor support) 

 CAN monitor PCAN-View for Windows 

 CAN monitor PCAN-View for DOS 

 Programming interface PCAN-Basic for developing applications 
with CAN connection 

 Programming interfaces for standardized protocols from the 
automotive sector 

 Manual in PDF format 
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2 Configuration and 
Installation 

This chapter covers the configuration, the software setup for the 
PCAN-PC/104 card under Windows, and the card installation in the 
computer. 

2.1 Configuring the Card 

Before installing the PCAN-PC/104 card into the computer you may 
need to configure it. For each CAN channel an interrupt (IRQ) and an 
I/O address range is set for operation in the computer. 

At delivery the PCAN-PC/104 card has the following default settings: 

CAN channel IRQ I/O address range Comment 

1 10 300h – 31Fh  

2 5 320h – 33Fh Dual Channel model only 
 

Tip: If the given resources are not permanently allocated by 
other devices, you can skip the configuration and directly 
continue with the following manual section 2.2. 

For a configuration differing from the default settings you need to 
set jumpers on the PCAN-PC/104 PCB according to the following 
explanations. 

Attention! Electrostatic discharge (ESD) can damage or destroy 
components on the PCAN-PC/104 card. Take precautions to 
avoid ESD when handling the card. 
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2.1.1 Interrupt 

An interrupt (IRQ) must be assigned to each CAN channel. This is 
done with a single jumper on jumper field JP1 for CAN channel 1 
and jumper field JP2 for CAN channel 2 (latter refers only to the 
Dual Channel model). The PCAN-PC/104 card supports the inter-
rupts 3, 4, 5, 7, 10, 11, 12, and 15. The default setting at delivery for 
CAN channel 1 is interrupt 10, for CAN channel 2 interrupt 5. 

 
Figure 1: Position of the jumper fields for setting the interrupts,  

JP1 for CAN channel 1 (lower jumper field),  
JP2 for CAN channel 2 (upper jumper field,  

Dual Channel model only) 

It is possible to share the same interrupt between two existing CAN 
channels. Therefore, you can configure the same interrupt when 
using two PCAN-PC/104 cards in the same computer. 

Tip: We suggest to configure different interrupts as long as 
resources allow it and use interrupt sharing only if this is not 
the case. 
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2.1.2 I/O Address Range 

Each CAN channel must be assigned to an unique I/O address range 
in the computer. An address space from 200h up to 39Fh and 3E0h 
to 3FFh (h = hexadecimal) is available. PCAN-PC/104 uses 32 addres-
ses beginning from the configured base address. The configuration 
is done on jumper field JP3 for CAN channel 1 and jumper field JP4 
for CAN channel 2 (latter refers only to the Dual Channel model). 
One or several jumpers are needed for each jumper field. 

 
Figure 2: Position of the jumper fields for setting the I/O base addresses,  

JP3 for CAN channel 1 (left jumper field),  
JP4 for CAN channel 2 (right jumper field, Dual Channel model only) 

The following table shows the possible settings. The X stands for a 
set jumper. The default settings at delivery for CAN channels 1 and 
2 are highlighted. 

Continued on the next page 
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Jumper field JP3/JP4 

A B C D E 
I/O address range 

X     200h – 21Fh 

X    X 220h – 23Fh 

X   X  240h – 25Fh 

X   X X 260h – 27Fh 

X  X   280h – 29Fh 

X  X  X 2A0h – 2BFh 

X  X X  2C0h – 2DFh 

X  X X X 2E0h – 2FFh 

X X    300h – 31Fh 

X X   X 320h – 33Fh 

X X  X  340h – 35Fh 

X X  X X 360h – 37Fh 

X X X   380h – 39Fh 

X X X X X 3E0h – 3FFh 
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2.2 Installing the Software 

Install the driver before you install the card. 

Do the following to install the driver: 

1. Start Intro.exe from the supplied DVD. 

The navigation program starts. 

2. Select in the main menu Drivers and click on Install now. 

3. Confirm the message of the User Account Control related to 
"Installer database of PEAK Drivers". 

The driver setup starts. 

4. Follow the program instructions until the Costum Setup is 
displayed. 

 
Figure 3: Driver selection in the PEAK-Drivers Setup 

5. Deselect the CAN device drivers and select CAN device 
drivers Non-Plug-and-Play (see Figure 3). 
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Node: The CAN device drivers Non-Plug-and-Play is only 
available under 32-bit Windows. PCAN-PC104 does not work 
under 64-bit Windows. 

6. Follow the further instructions. 

2.3 Installing the Hardware 

Do the following to install card into the PC/104 stack: 

Attention! Electrostatic discharge (ESD) can damage or destroy 
components on the card. Take precautions to avoid ESD. 

1. Shut down the computer. 

2. Disconnect the computer from the power supply. 

3. Plug the PCAN-PC/104 card onto a PC/104 connector. 

4. Interconnect the connector for each CAN channel on the 
PCAN-PC/104 card (see Figure 4) with the CAN connector of 
the slot bracket using the attached flat cable. 

5. Reconnect the power supply of the computer. 

Note: Before switching on the computer, please follow the pro-
cedure for modifying the computer's BIOS settings described in 
the following section. 
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Figure 4: Connectors for the flat cables to the CAN connectors,  

J3 for CAN channel one (lower position),  
J4 for CAN channel 2 (upper position, Dual Channel model only) 
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2.4 Modifying the Computer's BIOS Settings 

To ensure a flawless operation of the PCAN-PC/104 card it is neces-
sary that you adjust settings in the BIOS setup of the computer: 

 Indicate used interrupts 

 Deactivate the APIC mode 

Note: Due to a diversity of existing BIOS setup versions for 
computers we cannot give detailed instructions here. Instead 
we indicate common setting names. 

In order to know how to start the computer's BIOS setup please 
consult the corresponding documentation. Usually you can enter 
the BIOS setup by pressing the  Del  or  F2  key shortly after 
switching on the computer. 

2.4.1 Indicating Used Interrupts 

By indicating the interrupts that are set on the PCAN-PC/104 card, 
you avoid that the corresponding resources are automatically 
assigned to other devices and that this results in conflicts. 

In the BIOS setup itself you can often find the settings for the 
interrupts under a menu item containing the text PnP. For the 
interrupt(s) used by PCAN-PC/104 change the setting to Reserved or 
Legacy ISA. 
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2.4.2 Deactivating the APIC Mode 

Note: Do not mix up APIC with ACPI. 

The APIC mode is a certain type of interrupt management in a 
computer. 

If the APIC mode is active in your computer, you must deactivate it 
so that the PCAN-PC/104 card can work properly with interrupts. 

Do the following to determine in Windows if the APIC mode is 
active: 

Open the Windows Device Manager. 

1. Select the menu entry View > Resources by type. 

2. Open the branch of Interrupt request (IRQ). 

If entries with interrupt numbers greater than 15 are listed, 
the APIC mode is active and you must deactivate it. 

Do the following to deactivate the APIC mode: 

Important note: When you deactivate the APIC mode in the 
BIOS setup, it may happen that you must reinstall Windows 
afterwards, because it cannot start anymore due to the low-
level setting. 

Restart the computer and switch to the BIOS setup. 

1. Search for the APIC setting and deactivate it. 

2. Save the changes in the BIOS and quit the BIOS setup. 

3. If Windows doesn't start properly, reinstall it or perform a 
repair installation. 
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3 Connecting the CAN Bus 

3.1 Connection over D-Sub Connector 

A High-speed CAN bus (ISO 11898-2) is connected to the 9-pin 
D-Sub connector. The pin assignment corresponds to the 
specification CiA® 303-1. 

 
Figure 5: Pin assignment High-speed CAN  
(view onto connector of the slot bracket) 

Low power devices (e.g. bus converters) can be supplied directly 
with 5 volts over pin 1 and/or pin 9 of the CAN connector. Pin 1 
and/or pin 9 are not in use at the delivery state. For more 
information see the next section 3.2. 
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The pin assignment between the D-Sub port and the 10-pin connec-
tor on the PCAN-PC/104 card is as follows: 

 
Figure 6: Numbering at the 10-pin connector 

Pin Assignment 
Assignment 

D-Sub 

1 +5 V (optional) 1 

2 GND 6 

3 CAN_L 2 

4 CAN_H 7 

5 GND 3 

6 not connected 8 

7 not connected 4 

8 +5 V (optional) 9 

9 not connected 5 

10 not connected  
 

Tip: You can connect a CAN bus with a different transmission 
standard via a bus converter. PEAK-System offers different bus 
converter modules (e.g. PCAN-TJA1054 for a Low-speed CAN 
bus according to ISO 11898-3). 
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3.1.1 Slot Bracket with D-Sub Connectors 

 
Figure 7: Single channel slot bracket 

 
Figure 8: Dual channel slot bracket 

 

To connect a CAN bus to the PCAN-PC/104 card, use the supplied 
slot brackets. After you have connected the cables from the slot 
bracket with the 10-pin sockets, you can connect the CAN busses 
with the D-Sub sockets. 
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3.2 Voltage Supply of External Devices 

External devices with low power consumption (e.g. bus converters) 
can be directly supplied via the CAN connector (independently for 
each connector on the Dual Channel versions). With a solder bridge 
per CAN channel on the PCAN-PC/104 board, a 5-Volt supply can 
optionally be routed to pin 1 and/or pin 9 of the D-Sub connector. 

The opto-decoupled models of the card contain an interconnected 
DC/DC converter. Therefore, the current output is limited to about 
50 mA. 

Do the following to activate the voltage supply: 

Risk of short circuit! Solder with great care to avoid unwanted 
short circuits on the card. 

Attention! Electrostatic discharge (ESD) can damage or destroy 
components on the card. Take precautions to avoid ESD. 

Set the solder bridge(s) on the card according to the desired 
settings. 

Figure 9 shows the solder field positions on the card. The table 
below contains the possible settings. 
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Figure 9: Position of the solder jumper fields for the 5-Volt supply  

(JP5 lower position, JP6 upper position) 

5-Volt supply 
D-Sub connector Solder field Without 

(Standard) 
Pin 1 Pin 9 Pin 1 and 

pin 9 

CAN 1 JP5 

    
CAN 2 JP6 

    
 

Risk of short circuit! The 5-Volt supply is not protected 
separately. Therefore, turn off the computer before you 
connect and disconnect CAN cables or peripheral  systems. 
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3.3 Cabling 

3.3.1 Termination 

A High-speed CAN bus (ISO 11898-2) must be terminated with 120 
ohms at both ends. The termination prevents interfering signal 
reflections and ensures the proper operation of the transceivers of 
the connected CAN nodes (CAN interfaces, control devices). 

The PCAN-PC/104 card does not have an internal termination. Use 
the adapter on a terminated CAN bus. 

3.3.2 Example of a Connection 

 
Figure 10: Simple CAN connection 

This example shows a connection between the PCAN-PC/104 card 
and a control unit. The connection cable is terminated with 120 
ohms at both ends. 
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3.3.3 Maximum Bus Length 

High-Speed-CAN networks may have bit rates of up to 1 Mbit/s. The 
maximum bus length is primarily depending on the bit rate. 

The following table shows the maximum CAN bus length at diffe-
rent bit rates: 

Bit rate Bus length 

1 Mbit/s 40 m 

500 kbit/s 110 m 

250 kbit/s 240 m 

125 kbit/s 500 m 

50 kbit/s 1.3 km 

20 kbit/s 3.3 km 

10 kbit/s 6.6 km 

5 kbit/s 13.0 km 
 

The listed values have been calculated on the basis of an idealized 
system and can differ from reality. 
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4 Software and API 

This chapter covers the provided software PCAN-View and the 
programming interface PCAN-Basic. 

4.1 Monitor Software PCAN-View 

PCAN-View is simple Windows software for viewing, transmitting, 
and logging CAN and CAN FD messages. 

Note: This chapter describes the use of PCAN-View with a CAN 
adapter. 

 
Figure 11: PCAN-View for Windows 
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Do the following to start and initialize PCAN-View: 

1. Open the Windows Start menu and select PCAN-View. 

The Connect dialog box appears. 

 
Figure 12: Selection of the CAN specific 
hardware and parameters (exemplary) 

2. Select an interface from the list and continue with step 7. 

3. If no entry is in the list, press the button Add. 

The dialog box Add CAN hardware appears. 

 
Figure 13: Selection of the hardware 

4. Select PEAK ISA-CAN SJA. 
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5. Enter the port address and the interrupt (see section 2). 

6. Confirm your input with OK. 

7. From the drop-down list, select the Bit rate that is used by 
all nodes on the CAN bus. 

Tip: You can create custom bit rates by using the button (). 

8. Under Filter settings you can limit the range of CAN IDs to 
be received, either for standard frames (11-bit IDs) or for 
extended frames (29-bit IDs). 

9. Activate the Listen-only mode if you do not actively 
participate in the CAN traffic and just want to observe. This 
also avoids an unintended disruption of an unknown CAN 
environment (e.g. due to different bit rates). 

10. Confirm the settings in the dialog box with OK. The main 
window of PCAN-View appears (see Figure 14). 
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4.1.1 Receive/Transmit Tab 

 
Figure 14: Receive/Transmit tab 

The Receive/Transmit tab is the main element of PCAN-View. It 
contains two lists, one for received messages and one for the 
transmit messages. The CAN data format is hexadecimal by default. 

Do the following to transmit a CAN message with PCAN-View: 

1. Select the menu command Transmit > New Message 
(alternatively  or  Ins ). 

The New Transmit Message dialog box appears. 

 
Figure 15: Dialog box new transmit message 
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2. Enter the ID, the data Length, and the CAN message Data. 

Note: With the program version 4 of PCAN-View, the DLC field 
was renamed to Length. Latter reflects the actual data length. 

3. Enter a value into the Cycle Time field to choose manually 
or periodically message transmission. Enter a value greater 
than 0 to transmit periodically. Enter the value 0 to transmit 
only manually. 

4. Confirm the entries with OK. 

The created transmit message appears on the 
Receive/Transmit tab. 

5. Trigger selected transmit messages manually with the menu 
command Transmit > Send (alternatively  Space  bar). The 
manual transmission for CAN messages being transmitted 
periodically is carried out additionally. 

Tip: Using the menu command File > Save the current transmit 
messages can be saved to a list and loaded for reuse later on. 
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4.1.2 Trace Tab 

 
Figure 16: Trace tab 

On the Trace tab, the data tracer (data logger) of PCAN-View is used 
for logging the communication on a CAN bus. During this process 
the messages are cached in the working memory of the PC. 
Afterwards they can be saved to a file. 

The Tracer runs either in linear or in ring buffer mode. The linear 
buffer mode stops the Tracer as soon as the buffer is full. The ring 
buffer mode overwrites the oldest messages by new ones as soon 
as the buffer is full. 



PCAN-PC/104 – User Manual 
 

30 

4.1.3 PCAN-PC/104 Tab 

 
Figure 17: PCAN-PCI tab (examplary) 

The PCAN-PC/104-Plus tab contains some detailed information 
about the hardware and driver. 

4.1.4 Status Bar 

 
Figure 18: Display of the status bar 

The status bar shows information about the current CAN 
connection, about error counters (Overruns, QXmtFull) and shows 
error messages. 

You can find further information about the use of PCAN-View in the 
help which you can invoke in the program via the Help menu or 
with the  F1  key. 
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4.2 Linking Own Programs with PCAN-Basic 

 
Figure 19: PCAN-Basic 

On the provided DVD, you can find files of the programming 
interface PCAN-Basic in the directory branch Develop. This API 
provides basic functions for linking own programs to CAN- and CAN 
FD interfaces by PEAK-System and can be used for the following 
operating systems: 

 Windows 10, 8.1, 7 (32/64-bit) 

 Windows CE 6.x (x86/ARMv4) 

 Linux (32/64-bit) 
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The API is designed for cross-platform use. Therefore software 
projects can easily ported between platforms with low efforts. For 
all common programming languages examples are available. 

Beginning with version 4, PCAN-Basic supports the new CAN FD 
standard (CAN with Flexible Data Rate) which is primarily 
characterized by higher bandwidth for data transfer. 

4.2.1 Features of PCAN-Basic 

 API for developing applications with CAN and CAN FD 
connection 

 Access to the CAN channels of a PCAN-Gateway via the new 
PCAN-LAN device type 

 Supports the operating systems Windows 10, 8.1, 7 (32/64-bit), 
Windows CE 6.x, and Linux (32/64-bit) 

 Multiple PEAK-System applications and your own can be 
operated on a physical channel at the same time 

 Use of a single DLL for all supported hardware types 

 Use of up to 16 channels for each hardware unit (depending on 
the PEAK CAN interface used) 

 Simple switching between channels of a PEAK CAN interface 

 Driver-internal buffering of 32,768 messages per CAN channel 

 Precision of time stamps on received messages up to 1 μs 
(depending on the PEAK CAN interface used) 

 Supports PEAK-System‘s trace formats version 1.1 and 2.0 (for 
CAN FD applications) 

 Access to specific hardware parameters, such as listen-only 
mode 

 Notification of the application through Windows events when a 
message is received 
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 Extended system for debugging operations 

 Multilingual debugging output 

 Output language depends on operating system 

 Debugging information can be defined individually 

Tip: An overview of the API functions is located in the header 
files. You can find detailed information about the PCAN-Basic 
API on the provided DVD in the text and help files (file name 
extensions .txt and .chm). 

4.2.2 Principle Description of the API 

The PCAN-Basic API is the interface between the user application 
and device driver. In Windows operating systems this is a DLL 
(Dynamic Link Library). 

The sequence of accessing the CAN interface is divided into three 
phases: 

1. Initialization 

2. Interaction 

3. Completion 

Initialization 

A channel must be initialized before using it. This is done by the 
simple call of the function CAN_Initialize for CAN and 
CAN_InitializeFD for CAN FD. Depending on the type of the CAN 
hardware, up to 16 CAN channels can be opened at the same time. 
After a successful initialization the CAN channel is ready. No further 
configuration steps are required. 

Interaction 

For receiving and transmitting messages the functions CAN_Read 
and CAN_Write as well as CAN_ReadFD and CAN_WriteFD are 
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available. Additional settings can be made, e.g. setting up message 
filters to confine to specific CAN IDs or setting the CAN controller to 
listen-only mode. 

When receiving CAN messages, events are used for an automatic 
notification of an application (client). This offers the following 
advantages: 

 The application no longer needs to check for received messages 
periodically (no polling). 

 The response time at reception is reduced. 

Completion 

To end the communication the function CAN_Uninitialize is 
called in order to release the reserved resources for the CAN 
channel, among others. In addition the CAN channel is marked as 
"Free" and is available to other applications. 

4.2.3 Notes about the License 

Device drivers, the interface DLL, and further files needed for linking 
are property of the PEAK-System Technik GmbH and may be used 
only in connection with a hardware component purchased from 
PEAK-System or one of its partners. If a CAN hardware component 
of third-party suppliers should be compatible to one of PEAK-
System, then you are not allowed to use or to pass on the driver 
software of PEAK-System. 

If a third-party supplier develops software based on the PCAN-Basic 
and problems occur during the use of this software, consult the 
software provider. 
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5 Technical Specifications 

Connectors  

PC/104 ISA bus with 8 MHz clock rate, 16 bit bus width 

CAN D-Sub (m), 9 pins 
Pin assignment according to specification CiA® 303-1 

 

CAN  

Specification ISO 11898-2, High-speed CAN 
2.0A (standard format) and 2.0B (extended format) 

Bit rates 5 kbit/s - 1 Mbit/s 

Controller NXP SJA1000 

Transceiver NXP PCA82C251 

Galvanic isolation PCAN-PC/104: none 
PCAN-PC/104 opto: up to 500 V, separate for each CAN 

channel 

Supplying external 
devices 

PCAN-PC/104: D-Sub pin 1/9; 5 V, max. 100 mA 
PCAN-PC/104 opto: D-Sub pin 1/9; 5 V, max. 50 mA 
via solder bridge(s), not assigned at delivery 

 

Power supply  

Supply voltage 5 V 

Current consumption PCAN-PC/104 Single Channel: max. 150 mA 
PCAN-PC/104 Dual Channel: max. 170 mA 
PCAN-PC/104 Single Channel opto: max. 210 mA 
PCAN-PC/104 Dual Channel opto: max. 270 mA 

 

Measures  

Size 96 x 91 x 24 mm 
(see also dimension drawing Appendix B on page 38) 

Weight PCAN-PC/104 Single Channel: 57 g 
PCAN-PC/104 Dual Channel: 63 g 
PCAN-PC/104 Single Channel opto: 59 g 
PCAN-PC/104 Dual Channel opto: 65 g 

Continued on the next page 
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Environment  

Operating temperature -40 - +85 °C (-40 - +185 °F) 

Temperature for storage 
and transport 

-40 - +125 °C (-40 - +257 °F) 

Relative humidity 15 - 90 %, not condensing 

EMC Directive 2014/30/EU 
DIN EN 55024:2016-05 
DIN EN 55022:2011-12 

 

 



PCAN-PC/104 – User Manual 
 

37 

Appendix A CE Certificate 
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Appendix B Dimension Drawing 

 
Figure 20: View PCAN-PC/104 

The figure does not show the actual size of the product. 
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Appendix C Quick Reference 

Default setting at delivery 

CAN channel IRQ I/O address range Comment 

1 10 300h – 31Fh  

2 5 320h – 33Fh Dual Channel model only 
 

Software/Hardware Installation under Windows 

Install the driver from the supplied DVD. Turn off the computer. 
Insert the PCAN-PC/104 card in the PC/104 stack. After switching on 
the computer, enter the BIOS setup. In the PnP table mark the 
interrupts used by the PCAN-PC/104 card as reserved. 

Getting Started under Windows 

Run the CAN monitor PCAN-View from the Windows Start menu as 
a sample application for accessing the PCAN-PC/104 card. For 
initialization of the card, indicate the parameters (I/O base address, 
interrupt) and select the CAN connection and the CAN bit rate. 

CAN connector (D-Sub, 9-pin) 
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